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ABSTRACT

The ADS1x18 Evaluation Module (EVM) allows users to evaluate the functionality of the Texas Instruments 16-
bit ADS1118 or the 12-bit ADS1018. ADS1x18 refers to what is common to both devices and EVMs. Any
differences in operation between the devices or EVMs is listed separately. The ADS1x18 devices are ultrasmall,
low-power analog-to-digital converter (ADC) with integrated temperature sensor. Each ADS1x18 device has
inputs that can be configured as four single-ended or two differential inputs. The user’s guide describes both the
EVM hardware platform and the graphical user interface (GUI) software used to configure and operate the
device. The user’s guide also includes the EVM schematic diagram, board layout and bill of materials. The EVM
platform eases the evaluation of the ADS1x18 device with hardware, software and computer connectivity
through the universal serial bus (USB) interface.
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1 Introduction

The ADS1x18EVM is a fully-assembled evaluation platform designed to highlight the ADS1x18 features and
modes of operation that make this device suitable for low-power applications. The EVM sits on top of an
accompanying Precision ADC Motherboard (PAMBoard) used as a USB-to-PC GUI communication bridge. The
board combination also serves as an example implementation of connecting a microcontroller (MCU) to
communicate with the ADS1x18 device through a serial-peripheral interface (SPI).

Note

The ADS1x18 EVM requires an external controller to evaluate the ADS1x18 device.

The PAMBoard is controlled by commands received from the ADS1x18EVM GUI, and returns data to the GUI for
display and analysis. If the PAMBoard is not used, the EVM plug-in module format allows for an alternative
external host to communicate with the ADS1x18 by connection through the pin headers J1 through J4.
Connections to the header are identified on the PCB silkscreen and listed in Table 2-1.

The combined ADS1x18EVM and PAMBoard incorporates the following features:

+ ADS1x18, four input-channel ADC with header or screw terminal block input connections

» Voltage selection of 3.3 V or 5 V operation for the ADS1x18 with level-shifting to the 3.3-V MCU
* Full-scale ranges from 256 mV to 6.144 VV

* SPI for communication and configuration

3.3v
VDD Analog Power LaunchPad
Source 5V Power
vDD 3.3V 3.3v
Analog Header
and A:Eg%g’zl.r?ipuls ADG SPI/GPIO Level LaunchPad 12¢ EE:EGO g
Terminal Block fiers Shifter Interface
Figure 1-1. ADS1x18EVM Functional Block Diagram
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2 ADS1x18EVM Overview

Various onboard components are used to interface the analog input, digital interface, and provide power to the
ADS1x18 device. The functional block diagram shows an ADS1x18EVM board overview.

2.1 ADS1x18EVM-to-PAMBoard Interface

The ADS1x18 supports the digital SPI and functional modes as detailed in the ADS1118 Ultrasmall, SPI-
Compatible, 16-Bit Analog-to-Digital Converter Data Sheet (or the ADS1018 12-Bit Analog-to-Digital Data
Sheet). The PAMBoard operates at a 3.3-V logic level and the digital I/O lines of the ADC are level shifted to
match the operating voltage of the ADS1x18.

Digital interface connections to the PAMBoard include power, 12C, SPI and a GPIO connection used for
triggering an interrupt at the end of conversion signifying new data are available. The digital connections are
highlighted in the silkscreen as shown in Figure 2-1. Details regarding the connections are shown in Table 2-1.

ADS1X18EVM Texas

INSTRI"ENTS

3.3u

I 51 440 2032
13 J
C: c AVED:  cio =
| K
LT
= U | " -
uz

Figure 2-1. ADS1x18EVM-to-PAMBoard Connections

Table 2-1. ADS1x18EVM Header Pinout and Description

Description | Connector | Connector | Description | Description | Connector | Connector | Description
+3.3V J1:1 J3:21 +5V J4:40 J2:20 SND
J1:2 J3:22 GND J4:39 J2:19
J1:3 J3:23 J4:38 J2:18
J1:4 J3:24 J4:37 J2:17
J1:5 J3:25 J4:36 J2:16
J1:6 J3:26 J4:35 J2:15 SPI MAIN OUT
(DIN)
SPI SCLK J1:7 J3:27 J4:34 J2:14 SPI MAIN IN
(DOUT)
J1:8 J3:28 J4:33 J2:13
12C SCL J1:9 J3:29 J4:32 J2:12 SPICS
12C SDA J1:10 J3:30 DOUT/DRDY J4:31 J2:11
SBAU357 — OCTOBER 2020 ADS1x18EVM User's Guide 5
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2.2 Digital Interface

As noted in ADS1x18EVM-to-PAMBoard Interface, the ADS1x18 interfaces with the PAMBoard. The PAMBoard
communicates with the computer over USB. The two devices on the EVM requiring communication are the
ADS1x18 ADC (U1) using SPI and the electrically erasable programmable read-only memory (EEPROM) (U3)
using I12C (see Figure 5-5). The EEPROM is preprogrammed with the information required to configure and
initialize the ADS1x18EVM GUI software platform. Once the hardware is initialized through the software, the
EEPROM is no longer used.

The PAMBoard and EEPROM (U3) use 3.3 V for the device interface logic levels. The ADS1x18 can operate at
either 3.3 V or 5 V as desired by jumper selection JP1. To allow the ADS1x18 to operate at 5 V logic levels, a
logic level translator (U2) is used.

2.3 Analog Input Connections

The ADS1x18 device is designed for easy interface to an external sensor that is differential or single-ended
using either a header (J6) or a screw terminal block (J5). Connector J6 provides an easy interface connection for
differential input pairs with each pair separated by analog ground. Table 2-2 lists the channel input connections
for J5 and Table 2-3 shows the input connections for J6. Both connectors are clearly labeled on the PCB
silkscreen for easy input connection identification.

Connector J5 is a screw terminal block for attaching an external sensor with bare wire connections. The terminal
block includes all four inputs and a connection point for analog ground. See Figure 2-2 for the input layout.

Table 2-2. Terminal Block Input (J5)

J5 Terminal Block Inputs Description
J5:1 Analog input for AINO of the ADC
J5:2 Analog input for AIN1 of the ADC
J5:3 Analog input for AIN2 of the ADC
J5:4 Analog input for AIN3 of the ADC
J5:5 Analog Ground

Figure 2-2. Analog Input Terminal Block (J5)

Connector J6 is a 100-mil spaced dual row header. Jumper wire or clip leads can be used for connections. The
header includes all four inputs and two analog ground connections. See Figure 2-3 for the input layout.

Table 2-3. Terminal Block Input (J6)

J6 Terminal Block Inputs Description
J6:1 Analog input for AINO of the ADC
J6:2 Analog input for AIN1 of the ADC
J6:3 and J6:4 Analog Ground
J6:5 Analog input for AIN2 of the ADC
J6:6 Analog input for AIN3 of the ADC
6 ADS1x18EVM User's Guide SBAU357 — OCTOBER 2020
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Figure 2-3. Analog Input Header (J6)

Each analog input includes a single-order low-pass filter. The single-ended input filter cutoff frequency is 67.9
kHz. Up to four separate single-ended measurements are possible.

Instead of single-ended measurements, up to two differential input pair combinations are possible. The filter
design for the differential input pair filtering has a cutoff frequency of 3.4 kHz. The filter is populated on the
ADS1x18EVM for input pair combinations of AINO and AIN1 or AIN2 and AIN3. The input combination of AIN1
and AIN2 is possible by adding a 47nF capacitor at C6 (see location in the schematic).

The configuration options for the ADS1x18 allow for a potential full-scale range (FSR) greater than the
supply. This is useful when an input voltage slightly exceeds the next lower FSR. However, the input
voltage should not exceed the range of the VDD supply selected at JP1. The absolute input voltage is
bounded by VDD + 0.3 V and GND - 0.3 V. Damage to the ADS1x18 may occur if the absolute input
range is exceeded.
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2.4 Power Supply Options

The ADS1x18 supports a wide range of supply voltage from 2 V to 5.5 V. The ADS1x18EVM ADC voltage (VDD)
can operate from either 3.3 V or 5 V. The power is supplied from the USB 5 V source to the PAMBoard.
However, the USB power supply voltage is not consistent from PC to PC. A DC-DC converter increases the USB
output to 5.5 V. A linear low drop out (LDO) regulator uses the 5.5 V to establish a clean and stable 5V and 3.3
V for the ADS1x18EVM.

When the USB cable is plugged into the PC two LEDs will light on the PAMBoard (see Figure 2-4). The bottom
LED (D5) indicates that the 5-V output is active. The top LED (D1) indicates that the ADS1x18EVM is ready to
communicate with the GUI.

Figure 2-4. LED Indicators D1 and D5

Jumper JP1 selects the operating voltage for the ADS1x18 (see Figure 2-5). When jumper JP1 is in the bottom
position the VDD to the ADS1x18 is set to 5-V and when in the top position the VDD supply is set 3.3-V.

ADS1X18EVM i3 Texas

INSTRUMENTS
3. 3u

Figure 2-5. ADS1x18 Supply Setting Jumper (JP1)
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3 ADS1x18EVM Setup and Operation

The ADS1x18EVM requires a communication driver and GUI software for device configuration and data
collection. Driver installation is automatic. The USB enumerates as a composite device for Communications
Device Class (CDC) and Bulk. The sending of commands is through CDC while data collection is by Bulk
transfers from the PAMBoard. Additional information regarding any driver issues is located within this FAQ.

3.1 EVM Plug-in Instructions

Install jumper JP1 to the desired ADS1x18 operating voltage. Connect the USB micro cable to the PAMBoard
and attach the other end of the cable to an available USB port on the PC.

3.2 ADS1x18EVM GUI and Tl Cloud Agent Installation
The following steps describe the ADS1x18 GUI software installation:

1. Verify that the micro USB to USB cable from the PAMBoard to a USB port on the computer is connected.

2. On the EVM landing page (ADS1118EVM or ADS1018EVM), the software is available through a web-based
GUI. Connecting to the GUI may require a login to a user account for access. (Software GUI)

3. First-time users may be prompted to download and install the browser extension for Firefox™ or Chrome™
and the Tl Cloud Agent Application as shown in Figure 3-1. Installing the T Cloud Agent is a one time
download and installation.

4. Refresh the GUI. The GUI should connect to the hardware. A green signal displays, and the Hardware
Connected indication shows on the bottom (see Figure 4-3).

Tl Cloud Agent Installation

Hardware interaction requires addional one lime set up. Please perform the actions fisted below and iy your operation again

Figure 3-1. Browser Extension and Tl Cloud Agent Installation
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4 ADS1x18EVM GUI

The Home page is the GUI start-up landing page. The Home page provides a high-level overview of the
ADS1x18 device. The horizontal menu bar at the top of the GUI shows the menu options:

* File

»  Options
* Tools

* Help

Figure 4-1. Menu Bar Options

The upper corner of the GUI shows vertical tabs available to navigate through the various GUI displays. The
vertical tabs starting at the top icon include:

« Home
¢ Chart
» Configuration

Figure 4-2. GUI Navigation Bar Options

The black ribbon at the bottom of the GUI shows connection status and log information. On GUI startup, the
software attempts to identify and verify that the EVM connected matches with the GUI. An EEPROM on the
ADS1x18EVM contains information specific to the EVM connected. A properly connected and identified EVM
displays as Device Connected with a green indicator and at the bottom as Hardware Connected in the status
ribbon.
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SBAU357 — OCTOBER 2020 ADS1x18EVM User's Guide 1

Submit Document Feedback
Copyright © 2020 Texas Instruments Incorporated


https://www.ti.com
https://www.ti.com/feedbackform/techdocfeedback?litnum=SBAU357&partnum=

13 TEXAS
INSTRUMENTS
ADS1x18EVM GUI www.ti.com

4.1 Menu Bar

The Menu bar across the top of the GUI displays the device name used on the EVM along with a number of
drop-down menu options.

4.1.1 Files Menu

The File drop-down menu displays available options. The options include:

* Program Device

* Analysis Data
— Save data
— Load data

* Register Data
— Save register
— Load register

|l Arysls Tate
P

1n

HOT AYAILABLE & im
Datasnoe Szhzmatic

&b TEns INsTRUMENTS

Figure 4-4. File Menu

The Program Device option should only be necessary if an important firmware change is required. If
reprogramming the PAMBoard firmware becomes necessary an additional pop-up box displays with information
on the programming procedure.

By using the Save data option the Analysis Data is saved to a comma separated values (CSV) formatted file for
further analysis using external programs. The data can also be loaded back into the GUI for further review or
analysis by selecting Load data.
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Figure 4-5. Analysis Data Options

Register Data can be saved for a particular configuration by selecting Save register settings. A previously saved

configuration can be loaded back into the GUI again when testing various device configurations by using Load
register settings.
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Figure 4-6. Register Data Options
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4.1.2 Options Menu

The Options drop-down provides information regarding the serial COM port the GUI is using. By selecting Serial
Port, the serial COM port information displays the current COM port settings in a pop-up dialog with options to
change the COM port or reconfigure the settings as necessary.

Toal: Help

REWIEE

- ® ADS1118 ©

HOT AVAILABLE B im [
Dalasnoct

Diggram

Figure 4-7. Options Menu
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Figure 4-8. Serial Port Configuration Settings
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4.1.3 Tools Menu

The Tools drop-down menu displays the Log pane option. The Log pane displays the activity information log at
the bottom of the GUI. The Log pane displays the same information as when clicking the book icon in the status
ribbon.

ADS1118|  Flle Options
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Figure 4-9. Tools Menu
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Figure 4-10. Logs Display
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4.1.4 Help Menu

The Help drop-down menu displays the following:

» E2E Support Forum providing a link to the E2E forum for asking questions or searching the E2E forum.
*  View README.md displays pertinent startup information not necessarily included in this guide.
» About displays specific information regarding the GUIl and EVM hardware.

ADS1118| File Optiong

- ® ADS1118 @

My o e P
DEWICE CONNECTET
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s
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Figure 4-11. Help Menu
Information specific to the GUI build and the connected hardware is found by selecting About from the drop-
down Help menu.
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Figure 4-12. Help Information (About)
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4.2 Navigation Bar

4.2.1 Home

The Home page includes links to a variety of information. The links include this user’s guide, the EVM
schematic, as well as support resources. In the center of the Home page is a diagram of the ADS1x18EVM.
Hovering over the portions of the EVM marked in red show a detail of jumper positions and pin connections for
the ADS1x18.

ADS1118| F

Figure 4-13. EVM Jumper Information

Next to the connection status indicator is an information icon. Clicking the icon displays specific information
regarding the ADS1x18EVM.

Figure 4-14. Connected Hardware Information

At the bottom of the GUI is a black ribbon with status information. The status shows if the hardware successfully
connects to the PC and the COM port used. The status ribbon displays regardless of the navigation page
selected.
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4.2.2 Chart

The Chart icon selects the available charting options for displaying conversion data. The data options include a
Time Domain, Histogram and FFT displays.

The Chart tab allows configuration of the Data Capture for the ADS1x18. At the upper the capture window is the
setting for the number of Samples to collect. To capture data, press the Collect Data button displayed at the
upper corner of the window.

Options. Tools Help.

Samples et COLLECT BATA

i sy WMaan std e [ Pt Pl

(odus odea) (Eadns (edas} o) Y o Fe)

Sample #

&3 Texas INsTRUMENTS

Figure 4-15. Data Capture Window

Conversion data collects when the Collect Data button is pressed. The button will change to Stop Collect and by
pressing the button while in this state the collection of conversion data will stop, otherwise the data is collected
for the number of Samples as given. The number of Samples can be changed prior to pressing Collect Data by
selecting the Samples and directly entering the desired number of samples or by clicking on the up and down
arrows. The number of samples cannot be changed while the data is being collected.

When the Collect Data operation is complete, the data will display with the calculated channel statistics and a
plot of the data in the chart window. Various icons for viewing the data include zoom, pan and home. The home
icon restores the graph to show all data collected. The viewing icons are underneath the statistics information on
the right side of the GUI.

Also on the right side of the chart window is a slide-out menu where configuration settings are displayed and
changes can be made for data collection.

4.2.2.1 Channel Statistics

When data collection completes, statistical information displays along with the charted data. The statistical
display for Time Domain and Histogram are the same, but the FFT statistics differ. As the ADS1x18 is primarily a
dc measurement device, the FFT plot and information may have little meaning.

4.2.2.1.1 Time Domain and Histogram Statistics
The Time Domain and Histogram plots share the same statistical information:

* Input Channels selected

*  Min code within the data set

* Max code within the data set

* Mean code value within the data set

» Std Dev representing the standard deviation within the data set
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* Pk-to-Pk representing the total noise peak-to-peak within the data set

» Eff. Res representing the effective resolution as number of bits with the value in parenthesis showing the
noise-free number of bits

File:

¥ nls &
- Data Capture Samples 120
i s |

Min Max Hzan 5t D |e] Phetn-Fh
{Codes) (Codes) {Cades) (Codes) {Godea)

Figure 4-16. Capture Statistics

4.2.2.1.2 FFT Statistics
The FFT plot displays the following statistics:

* Input Channels selected

* Fundamental frequency

* Fundamental power

* Noise floor

* SNR or signal-to-noise ratio

»  SFDR or spurious free dynamic range
* THD or total harmonic distortion

» SINAD or signal-to-noise and distortion
* ENOB or effective number of bits

* Harmonics
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Figure 4-17. FFT Statistics

4.2.2.2 Time Domain Plot

The Time Domain plot displays the sample count number in the X-axis. The Y-axis is displayed as either codes
or volts with the selection in a drop-down menu. The Y-axis drop-down menu displays next to the charting icons
near the right side of the GUI below the statistics.
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Figure 4-18. Time Domain Plot

4.2.2.3 Histogram Plot

The Histogram plot shows the number of occurrences a code or group of codes appear. User selection includes
a choice of:

» # of Bins selecting the number of bins to include in the plot
* Bin Size selecting the number of unique codes to include in each bin
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Figure 4-19. Histogram Plot

The # Bins and Bin Size are selectable options and display next to the charting icons near the right side of the
GUI below the statistics.

4.2.2.4 FFT Plot

The FFT plot is rather meaningless for dc input voltages. However, a low-frequency ac signal can be analyzed
and the FFT plot displayed.
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Figure 4-20. FFT Plot
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4.2.2.5 Capture Configuration Settings

A slide-out menu is viewable on the right side of the Chart window. By clicking the slide-out for Show Capture
Settings various configurations display and are selectable. The drop-down menu Capture Settings are:

» Select data rate for the data output conversion rate
» Select MUX channels by choosing the desired input channels to be converted
» Select FSR for choosing the voltage input measurement range

ADS1118| File

Options Toals

Figure 4-21. Capture Settings

4.2.3 Configuration

Capture Scttings

Select data rate:
128 3PS detault) ~

Select LUK chanmels:
AINZ - N3 w

Selert FSR:

+3 4R W {rofault) -

The Register Map window contains information about the configuration and the last conversion data from the
ADS1x18. The Conversion register contains the value of the last 16-bit conversion result read from the
ADS1118. For the ADS1018, the conversion data are 12-bit left-justified in the 16-bit register. As the ADS1x18 is
a programmable device, the Config register is the only programmable register and is 16 bits in length.

A number of control buttons and drop-down menus exist to configure the Register Map read and write operations

when data are written and read from the ADS1x18.

Throughout the Register Map window question mark icons appear. Clicking on these icons open details

pertaining to the items in the locations where they appear.
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Figure 4-22. Register Map

The only configurable register is the Config register. The GUI displays two registers even though there is only
one addressable register in the ADS1x18 device. For the firmware to remain in synchronization with the GUI, all
communication is conducted as 32-bit operations. The first 16-bit word returned is the conversion data. The
second 16-bit word returned is the ADS configuration in use by the ADS1x18 device. Each word is displayed as
register data even though there is no specified conversion register data within the ADS1x18 device. The
Register Map data is specific to the GUI and firmware combination for the ADS1x18EVM.

Configuration of the ADS1x18 device is accomplished using the drop-down menu and click options shown in the
Field View on the right side of the GUI window. It is also possible to double-click on the various bits to toggle the
bit settings. As the bit settings change, the Field View options will also change to correspond to the selection.
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Figure 4-23. ADS1x18 Configuration
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4.2.3.1 Register Read and Write Options

At the top and right side of the Register Map window are controls for reading and writing to the registers. The
startup default control values are to Immediately Write the Config register when options change. The Auto Read
register function is turned off.

= ADS1118 Fie
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Figure 4-24. Register Read and Write Controls

4.2.3.1.1 Read Register Options

The default GUI configuration is have the Aufo Read functionality turned off and instead manually read the
registers using the READ REGISTER and READ ALL REGISTERS buttons. The READ REGISTER button reads
only the selected register. The READ ALL REGISTERS button reads all registers available for the ADS1x18
device. The advantage of manually reading the register contents is a reduction in USB communication between
the ADS1x18EVM and the GUI.

The registers can be read automatically from the ADS1x18 at a variety of intervals from once a second to as fast
as possible. The intervals can be seen and selected by using the Aufo Read drop-down menu selection. The
READ REGISTER and READ ALL REGISTER button options are only enabled when the Auto Read selection is
turned off.
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Figure 4-25. Auto Read Options

4.2.3.1.2 Write Register Options

The GUI default option for register writes is Immediate Write. When Immediate Write is selected, any register
configuration changes are immediately written from the GUI to the ADS1x18 device. Using the Immediate Write
option ensures that what is being displayed is what is configured in the ADS1x18.

If the write register drop-down menu selection is for a Deferred Write, then the write register buttons WRITE
REGISTER and WRITE ALL REGISTERS become enabled. Similar to the functionality of the read register
buttons, the WRITE REGISTER button will write the configuration for the currently selected register. When
selecting the WRITE ALL REGISTERS button all configurable registers will be written.

Toals

i Q4 al y nam wan - [ sesich Rirtisits @ s Fiia Vi
et i i 5 Wwoon o o 9 0 7 [ 5 l a 2 1 [ CONFIG
° v Reghstors 1]
CENVERSON ey TaATE -
| e @ o as35e8 N [ T S R (A | 0 -

€D = COME11E200  Hordwore Conncoted. £ TExas INSTRUMENTS

Figure 4-26. Register Write Options
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4.3 Connection Status

Connection status shows at the bottom of the GUI in the black status ribbon. At the left side of the status ribbon
is a book icon that when selected, allows for the log information to be displayed. Next to the book icon is a
connection icon. The icon is showing the visual representation of the connection status also displayed as text.
The icon shows as a connected link when the EVM and GUI are connected, and appears as a broken link when
not connected. Clicking on the icon will attempt to connect if disconnected and will disconnect if the EVM is
currently connected. The last icon shows as an arrow and clicking the icon toggles the display of connection
details.
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Figure 4-27. Status Information
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Bill of Materials, Printed Circuit Board Layout, and Schematics

5 Bill of Materials, Printed Circuit Board Layout, and Schematics
This section contains the ADS1x18EVM bill of materials (BOM), printed-circuit board (PCB) layout, and board

schematic.

5.1 Bill of Materials

Table 5-1 lists the bill of materials (BOM) for the ADS1x18EVM.
Table 5-1. Bill of Materials

Designator | QTY |Description ManufacturerPart Number |Manufacturer
C1,C2,C3,C4 4 CAP, CERM, 4700 pF, 50 V, +/- 5%, X7R, 0603 C0603C472J5RACTU Kemet
C5,C7 CAP, CERM, 0.047 uF, 50 V, +/- 10%, X7R, 0603 |C1608X7R1H473K080AA TDK
C8, C10, C11, 4 CAP, CERM, 0.1 uF, 10 V, +/- 10%, X7R, 0402 CL05B104KP5NNNC Samsung Electro-
C12 Mechanics
C9 1 CAP, CERM, 1 uF, 10 V, +/- 10%, X7S, 0402 C1005X7S1A105K050BC TDK
C13,C14 2 CAP, CERM, 10 pF, 25 V,+/- 5%, X7R, AEC-Q200 |C1206C106J3RACAUTO Kemet
Grade 1, 1206
J1/J3, J2/J4 2 Receptacle, 2.54mm, 10x2, Tin, TH SSQ-110-03-T-D Samtec
J5 1 Terminal Block, 3.5mm Pitch, 5x1, TH ED555/5DS On-Shore
Technology
J6 1 Header, 100mil, 3x2, Gold, TH TSW-103-07-G-D Samtec
JP1 1 0.025" SQ Post Header, Through-hole, Vertical, -55 | TSW-103-07-G-S Samtec
to 125 degC, 2.54 mm Pitch, 3-Pin, Male, RoHS
R1, R2, R3, R4 4 RES, 499, 1%, 0.1 W, 0603 RCO0603FR-07499RL Yageo
R5, R6, R7, R8 4 RES, 47, 5%, 0.1 W, AEC-Q200 Grade 0, 0402 ERJ-2GEJ470X Panasonic
R9, R10 2 RES, 10 k, 5%, 0.1 W, AEC-Q200 Grade 0, 0402 |ERJ-2GEJ103X Panasonic
R11, R12 2 RES, 4.70 k, 1%, 0.1 W, 0402 ERJ-2RKF4701X Panasonic
SH-J1 1 Shunt, 100mil, Gold plated, Black SNT-100-BK-G Samtec
U1 1 16-Bit (or 12-bit), 860SPS (or 3300SPS), 4-Ch ADS1118IDGSR (or Texas Instruments
Delta-Sigma ADC w/ PGA, Oscillator, Voltage ADS1018IDGSR)
Reference, Temp Sensor & SPI, DGS0010A
(VSSOP-10)
u2 1 4-Bit Bidirectional Voltage-Level Shifter for Open- | TXS0104EPWR Texas Instruments
Drain and Push-Pull Applications, PW0014A
(TSSOP-14)
U3 1 I12C BUS EEPROM (2-Wire), TSSOP-B8 BR24G32FVT-3AGE2 Rohm
C6 0 CAP, CERM, 0.047 uF, 50 V, +/- 10%, X7R, 0603 |C1608X7R1H473K080AA TDK
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5.2 Printed Circuit Board Layout
Figure 5-1 to Figure 5-4 depict the ADS1x18EVM PCB layout.
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Figure 5-2. Top Layer
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5.3 Schematics

Figure 5-5 shows the ADS1x18EVM schematic.

—ae

il

sci
s

AINO DOUT/BRDY

AINL DIN

AIN2

AIN3 GND.

R1
499
L,
4.7nF
==C5
47nF
G\
55 R2
5 GND 499
el 4 AIN3 C:
3 AN a70F
g 2 AINL ==c6
f —T a70F T
oD
EDS55/5DS i~ ]
499
RN
a7nF
=
a70F
GND
R4 n
499
L.,
4.7nF
oD
16
AINO 1 > AN
5 e 4
AIN2 5 oI AN
7
D

R4 SCLK ADC
R6 47 TS ADC
R adl

DOUT ADC

ADST118IDGSR

R8 47 DIN ADC

SPI Level Shifter

[CEY

VoD LP_sv.

3V u
1 1
veea vees s I
DIN LP 20| e a1 |el3 DIN ADC
cio 433V
0.1uF DOUTIP  3.0p 82 foel2 DOUT ADC___ Analog_in
— J— P_UART_RX
e ] 83 kel G5 ADC P_UART_TX
GND Gho !
sakle sl 8o jol0sclcADC Analogin
SPI_CLK Analog_In/i2s_Ws (2L
£ N Ne 2 GPIO ! Analog_In/12s_SCLK  (—2&
12c_scL Analog_Out/i25_SDout (2
Z{ ano of [oE 12¢_sDA Analog_Out/125_sDin  [—3%
ngsomEPwa 50110037
GND
2014
PWM/GPIO | GND
PWM/GPIO | PWM/GPIO |
PWM/GPIO | GPIO|
PWM/GPIO ! =)
EEPROM Memory Timer_Cap/GPIO | RsT {16
Timer_Cap/GPIO | SP1_moOSI
GPI0 SPLMISO
Ro v GPI0 ! $PI_CS/GPIO |
’ GPIO! SPI_CS/GPIO !
- DoUT P ot Gpo
R10
C12 10k 55Q-110-03-T-D
0.10F
Launchpad Connectors
= GND
1 a0 vee 8
2| we |o7_EEPROM WE
ET P s foboscLle
4 vss SDA SDALP
BR24G32FVT-3AGE2
GND

Figure 5-5. ADS1x18EVM Schematic
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